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  Dreamweaver Basics 

 
 

Introduction 
 
Adobe Dreamweaver CS3 is a web authoring software that aids in the creation and maintenance of web 
pages.  Dreamweaver uses tools similar to those found in a word processing program to allow for the 
development of web pages without knowledge of HTML.  It also provides the option of hand-editing the 
HTML for greater control of the document.   
 

 
Contents 

 
This workshop will cover the following topics: 
 

• Opening Dreamweaver 
• Defining a Site  
• The Dreamweaver Work Area 
• Modifying Page Properties 
• Formatting Text 
• Saving Files 
• Adding Links 
• Adding E-Mail Links 
• Adding Anchors 
• Inserting Images 
• Inserting Tables 
• Laying Out a Page 

o Using Tables 
o Using Dreamweaver's Sample Pages 
o Using a Consistent Page Design for Multiple Pages 

• Previewing your Site 
• Uploading Files 
• Viewing your Published Site 
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Opening Dreamweaver 
 

To open Dreamweaver in the PHLI Training Room, double-click the Dreamweaver icon. 
 
To open Dreamweaver in the UM Computing Labs, go to Start ⇒ Programs ⇒ Web Authoring 
Software ⇒ Dreamweaver CS3.  This path may vary on your work or home computer.   

 
Defining a Site 

 
There are two parts to your website – your local files, and your remote files. You create local files on your 
computer using Dreamweaver, and upload them to your remote web space via FTP. It is very important 
that the files on your local computer are set up exactly the same as the files on your remote web 
server. That is, that they are all in the same location relative to each other.  
 
Before you can upload local files to a web server, you must create what Dreamweaver calls a Site File. 
Site Files contain information about where your files are stored locally, where they are stored remotely, 
and how they will be transferred back and forth between your computer and the web server. You should 
do this before you create your first web page. 
 
All UM students, faculty and staff have free website space available to them from ITCS. The URL of your 
personal website space is http://www-personal.umich.edu/~youruniquename/. All of your website files 
will be stored in the Public/html folder of your IFS space. Please see http://www-
personal.umich.edu/~pattyb/webspace.html for instructions on checking your web space. If you do not 
have an html folder, please contact ITCS. 
 
Location location location! 
 
If you are working in the PHLI Training Room or at a UM Computing Sites computer, like those in the 
basement computing lab of SPH II or the Public Health Library, you can connect to your web space via a 
network. You do not need to set up SFTP (secure file transfer protocol). If you are working from any other 
location, you will need to set up SFTP. Instructions for both are given here. 
 
 
To create a new Site File, click the Manage Sites link in your Site Files Panel. 
 

 

Manage Sites 
Link

 
The Manage Sites dialogue window will come up. Click New and then Site. The Site Definition wizard 
will come up: 
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Site Name: Give your site a desired name.  Type in a name that provides a meaningful description of 
your site. This will not appear anywhere on your web site. Click Next. 
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Do you want to use web server technology such as ColdFusion, ASP.NET, etc., on your site? 
Unless you know that you do, choose No and click Next. 
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From PHLI Training Room Computer 
 
How do you want to work with your files 
during development? Select "Edit directly 
on server using local network."  
 
Where are your files on the network? 
Click the folder icon and navigate to your 
Public/html folder in your AFS space: 

• choose network drive I 
• double-click the user folder 
• double-click the folder named for the 

first letter of your uniqname  
• double-click the folder named for the 

second letter of your uniqname  
 • double-click the folder named for 

your uniqname 

 

• double-click your Public folder 
• double-click your html folder 

 
From any Other Location 
 
How do you want to work with your files 
during development? Select "Edit local 
copies on your machine, then upload them 
to a server when ready." 
 
Where on your computer do you want to 
store your files? Click the folder icon and 
navigate to the folder where you want to 
keep your local files. 

 
 
Click Next. 
 



 

Please Note: If you working in the PHLI Training Room or at a UM Computing Sites computer, 
you should ignore this page. 
 

 
This next set of questions refer to the remote web server you are using. We will assume that 
you want to publish your website on the web server space you have available to you as a UM 
Staff, Student or Faculty. This web server is maintained by ITCS. 

• Connect to your remote server via FTP 
• The FTP address of your web server is sftp.itd.umich.edu 
• The name of the folder on the web server that you want to store your files in is probably 

named Public/html. Unfortunately, this is not true for everyone. For some people, the p 
in Public is not capitalized. If you enter these values and cannot connect to the web 
server, try it without specifying the folder. Once you connect, you can see what the 
folder is called and change your Site Files definition accordingly. If you do not have a 
Public/html folder, you will have to contact ITCS. 

• Your FTP login is your UM uniqname. 
• Your FTP password is your Kerberos password. 
• Be sure to check the box that says Use Secure FTP (SFTP). You will not be able to 

connect to the ITCS web server otherwise. 
 

     Fall, 2007 Dreamweaver Basics Page 6 



 

 
Change "How do you want to work with your files during development?" to Edit Directly on 
server using local network. Then click the folder icon next to the "Where are your files on 
the network?" box and navigate to the Public/html folder on the H: drive (your IFS space). 
 
Click the Test Connection button. If you have entered all of the information in successfully, 
you will see a message saying that you have connected successfully. Click OK and then 
Next. 
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Do you want to enable checking in and checking out files? Only say yes to this 
question if you will not be the only person updating this website. Enabling checking in and 
checking out makes it so that only one person can edit a single file at the same time. Click 
Next. 

 

 
 

You will see a summary of your Site Files definition. If everything looks good, click Done. 
 

You can modify your Site Files definition at any time by going to Manage Sites in the Site Files 
panel.  This will bring up the Site Definition dialogue box, where you can make the desired 
changes.  You can also have as many different Site Files as needed.  
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The Dreamweaver Work Area 
 

 
 

Document Window 
The Document Window is your work area where you create and edit your web page. 
 
Dreamweaver has the option to display the Document Window in three different ways: the code 
view, the design view, and the code and design view.  The code view shows HTML only.  The 
design view shows only the design, or the visual layout of your page.  The code and design view 
shows a combination of the two. 
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To toggle between the different views, go to View ⇒ and select Code, Design, or Code and 
Design.  You can also use the shortcut icons located at the upper left of your screen. 
 

 
Code Design

 
Code and Design 

 
Object Toolbar 
The Object Toolbar allow you to insert web objects into your web pages, such as images, forms 
and media. Each Group (such as “common” listed here) contains a group of specific objects. The 
Common group has everything you will need today. 

 

 
 
Site Files Panel 
The Site Files Panel is more than a file browser. It allows you to see the structure of all the files 
and directories in your website. You can open, move, copy, rename and delete files from the Site 
Files Panel. We will talk more about your Site Files later in the workshop. 

 

 
 
Properties Panel 
The Properties Panel provides details of the properties of a selected object.  The Properties Panel 
will change depending on the object or text that is selected.   
 

 
 

Tag Selector 
The Tag Selector is located in the bottom left corner of the screen.  It shows the HTML Tags that 
correspond to the area where your cursor is placed in the Document Window.  Selecting a tag in 
the Tag Selector it will select the corresponding area in the Document Window.  

 
 Example of the Tag Selector when the 

cursor is placed on a linked image that is 
inside of a table. 
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File Toolbar 
The Toolbar allows you to toggle between views, and shows the title of the document.  It also has 
shortcut icons that allow you to upload and download your file, and preview the page in a browser. 
 
 

 

Change Views 

Document Title
Upload/Download 

Preview/Debug in Browser

 
 
 
 

Other Panels  
 
There are several additional panels on the left side of the work area, including Design, 
Code, Application, and Tag Inspector. These panels are designed to provide additional 
information about Web Development. For example, the Code Panel allows you to look up 
HTML tags, CSS syntax, Javascript syntax, and much more. We will not cover these panels 
during this workshop. 

 
 

Modifying Page Properties  
 

When you modify the Page Properties by clicking the Page Properties Button in the Properties 
Panel (or going to Modify ⇒ Page Properties), you make global settings to your document.   
 

 
 

On the left side of the Page Properties window are several categories of page properties. The first 
one is Appearance. Here you can choose the default font-family, font size, font color, background 
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color, background image and all four margins for your document. You can still use different fonts 
and colors in different parts of your web page. This just sets the default settings for the entire page. 
 
Font Families 
 
You will notice that when you click the carrot for page font, there are not many fonts on the list. 
This is because the font you choose will only display in the user's browser if the user has that font 
installed on their machine. You may also notice that each item in the list contains more than one 
font, for example, "Arial, Helvetica, sans-serif." Sans serif is what is known as a font family, as are 
serif, fantasy, script and monospace. By choosing "Arial, Helvetica, sans-serif," you are saying "If 
the user has Arial installed, display my text in Arial. If they don't have Arial, but they have 
Helvetica, display my text in Helvetica. If they don't have Arial or Helvetica, display my text in 
whatever sans-serif font they have chosen as their default. 
 
Font Sizes 
 
It is important to choose a measurement of font size that allows users to increase or decrease the 
size of text on your page, or a relational font size. This is especially true for users with vision 
disabilities who need the text to be bigger in order to read it. While pixels is designed to relational, 
it is not treated as such by Internet Explorer. Try using 1 em instead of 12 pixels, or .8em instead 
of 10 pixels. 
 
Colors 
 
It is important to use highly-contrasting foreground and background colors. For example, if you use 
a dark background, choose a light text color.  Also, even if you want a white background and black 
text, you should select these, as gray is the default background color for the Netscape browser. 
 
All computer monitors can display 216 colors called the Browser Safe Colors. Browser Safe 
Colors are defined by a hex (six-character) code containing 00, 33, 66, 99, CC, or FF.  An example 
of a Browser Safe hex code is 33CCFF.  Dreamweaver allows you to choose from the 216 
available Browser Safe Colors by using the color picker: 
 

 
 
You can click the color wheel at the top of the color picker to find additional colors. 
 
Background Images 
 
Please note that background images tile on a web page. That means that they display over and 
over in rows and columns. If you use a background image, make sure that it is a small (usually 
around 100 pixels by 100 pixels) and will blend well when tiled. 
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Here is the Appearance category of the Page Properties dialogue box with values filled in.  
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Links 
 
The next thing you will define is the Links category. 
 

 
 
Here you can change the font face, size and color of the four link states: 
 

• Linked color: the color of linked text 
• Visited links: the color of links to pages that the user has already visited  
• Rollover links: the color of links while the user is rolling their mouse over them 
• Active links: the color of links while they are being clicked on 
 
You can also select an Underline style. The default is that links are always underlined, which 
users expect, but you can change it so that links are never underlined, are only underlined 
during mouse rollover, or are underlined except during mouse rollover. 
 
It is perfectly acceptable to leave these all on their defaults (which is blue underlined text for 
links and purple underlined text for visited links) but feel free to play around with these settings. 
What is most important is that your visited link color is different from your regular link color. This 
is a visual clue to users that they have already visited a page. 
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Headings 
 
The final category of Page Properties that you should set are Headings.  
 

 
 
Headings are used for page titles, section titles, sub-section titles, and so on. They are used to 
structure your web page. HTML offers six levels of headings, with Heading 1 being the largest and 
Heading 6 being the smallest. I rarely use more than three levels of headings to structure web 
pages.  
 
In the image above I have set the heading font, specified that all headings should be bold, and set 
the font sizes for headings one through three. Note that I again used the em measurement of font 
size so that users can increase and decrease the size of the text . 
 
Once your selections have been made, press Apply to apply the settings to the page and OK to 
accept the changes. 
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Page Titles for the Title Bar 
 
The last global page property that you will set is the page title for the title bar. The title bar is the 
blue space at the very top of every browser window, as circled in the below image: 
 

 
 
Enter the text that you want to appear in the title bar in the Dreamweaver title box: 
 

 
 
Whatever you enter there will appear in the web browser's title bar. Use short but descriptive page 
titles. 
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Formatting Text 
 
You can modify individual sections of text by using the Properties Panel.  First select the text you 
would like to change and then make the necessary changes by using the options available to you 
in the Properties Panel.  Using the available tools, you can: 
 

- Create headings and paragraphs 
- Change the face and size of the font 
- Change the color of the text 
- Create bold, or italic text 
- Adjust alignment to right, center, or left 
- Indent text 
- Create bulleted or numbered lists 

 
 

 

 

Format Left, Center, Right Bold/Italic 

Indent  Color 

Bulleted/Numbered List 

Font Type Font Size  
 
 
 

Formatting Headings and Paragraphs 
 
The first thing you want to put on your web page is the page title. Put your cursor in the document 
window and type in the page title. Next click the drop-down for the Format property in the 
Properties Panel. Here you see your choices: paragraph format, any of the six levels of headings, 
and Preformatted. Since the level 1 heading is the highest level, it should be used for page titles. 
Choose Heading 1 in the Format drop-down list: 
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To go to the next line, put your cursor at the end of your page title and click the Enter (or Return) 
button on your keyboard. Type in your first paragraph. Notice that the value of the Format property 
in the Properties Panel now says Paragraph. This is because Dreamweaver is smart enough to 
know that you wouldn't want two level-1 headings in a row.  
 
You might also notice that there is a blank line between your page title and your first paragraph. 
Any time you hit the Enter (or Return) button on your keyboard, you will skip down a line. This is 
because in HTML (the language web pages are written in) there is always a blank space between 
block-level objects on a page, such as headings and paragraphs.  If you want a line break instead 
of a paragraph break, hold down the Shift key while hitting Enter (or Return). 
 
You can select any words in your paragraph and change their font-face, font-size, color, and 
make them bold or italic by changing those properties in the Properties Panel. You can change 
the alignment of headings or paragraphs by clicking any of the alignment icons in the Properties 
panel. 
 
Lists 
 
There are two types of lists on web pages: Ordered (or numbered) and Unordered (or bulleted). 
To create a list, put your cursor just above where you want the list to be and hit Enter (or Return) to 
start a new paragraph. For an ordered list, click the Ordered List icon in the Properties Panel. For 
an umordered list, click the Unordered List icon in the Properties Panel.  
 
Type your first list item, and then hit Enter (or Return) to go the next line. Your list will continue. 
When you are finished with your list, hit Enter and click the Ordered or Unordered List icon again to 
turn it off (or just hit Enter twice). 
 
Nested Lists 
 
Let's say you want an unordered (bulleted) list nested inside an ordered (numbered) list as a sub-
list. Type in your ordered list, then put your cursor at the end of the line just above where you want 
your sub-list to start. Hit the Enter (or Return) button on your keyboard, then click the Indent Icon 
in the Properties Panel. Next, click the Unordered List icon in the Properties Panel to change the 
nested list to an unordered list. Type in your unordered list. When you want to return to your 
ordered list, hit Enter (or Return) and click the Ordered List icon in the Properties panel to resume 
your ordered list. Here is an example: 
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Saving Pages 
 
To save the web page you are working on, click the File drop-down menu and choose Save. 
Please note the following file naming conventions for the World Wide Web: 
 

1. All web page files must end with the extension .htm or .html. 
2. Your default homepage must be named index.htm or index.html.  
3. Use all lower-case letters and numbers in your file and folder names. 
4. Do not use spaces. 
5. Do not use special characters like &, %, etc. Underscores (_), dashes(-) and 

periods(.) are OK. 
 
If you are saving your work to your personal space on the UM web server, you may notice that you 
already have a file in your file list called index.html. It is fine to over-write this file. You cannot have 
two index files in your html folder, one named index.htm and the other named index.html. You 
should have only one default home page file. 
 
Once you have your page properties and formatting set, an easy way to create secondary pages is 
to click the File drop-down menu and choose Save As… Give the page a new file name and edit 
its content appropriately. 
 

Adding Links 
 
To add a link to another web page, first place your cursor where you want the link to appear. Next, 
click the Link icon on Common Object Toolbar. 
 

 
 

Click on Link icon  
 

The Hyperlink dialogue box will open. Here you will need to type in the text that you want to be 
clickable in the Text field, and the full URL of the webpage you want to link to in the Link field. The 
Target field allows you to have the link open in a new window by choosing “_blank.” If you do not 
want the link to open in a new window, leave the Target field blank. You may also leave the Tab 
Index, Title and Access Key fields blank. 
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But what if you want to make text that you have already typed link to another webpage? First select 
the text you would like activated as a link.  Once the text is selected, type in the full URL (e.g. 
http://www.sph.umich.edu) in the Link field of the Properties Panel.   
 

 
 

Link Field  
 

Adding Email Links 
 
 
Email Links are special links that you can use to make e-mail addresses on your webpage 
clickable. If your user has an email client installed on their computer, when they click an email link, 
their email client will open a new message addressed to the email address you have specified. 
 
To add an email link, first place your cursor where you want the link to appear. Next, click the 
Email Link icon on Common Object Toolbar. 
 

 
 

 
 
The Email Link dialogue box will open. Type in the text that you want to be clickable, and the e-
mail address, and click OK. 

Click on Email Link icon 
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Note: Email links are often harvested by robots that search the web, collecting email addresses for 
spammers. 
 

Adding Anchors 
 
Anchors are links that jump to a specified location within the same page.  Creating an Anchor is a 
two-step process.  First, you must indicate where you want the link to jump to in the page (name 
the anchor).  Then you have to create a link to that location (link to the named anchor). 
 
Creating a Named Anchor 
To create a Named Anchor, place the cursor in the Document Window in the location you would 
like your link to jump to.  Then click on the Named Anchor icon. 
 

 
 

 Click on the Named Anchor icon 
 
After clicking on the Named Anchor icon, an Insert Named Anchor dialog box will appear.  Type 
a short one-word name for the anchor in this.  Press OK.  The anchor has been named and you 
can now link to the anchor. 
 

 
 
Linking to a Named Anchor 
In the Document window, select the text you would like activated as a link.  In the Link Field of the 
Properties Panel, type the number sign (#) followed by the name of your anchor (e.g. type #top in 
the Link field if you named your anchor top).   
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Inserting Images 
 
To insert images into your web page, place the cursor in the Document window in the location you 
would like the image inserted.  Next, click on the Insert Image icon in Common Object Toolbar.  
This will open a dialogue box that will allow you search for the file where the image is located.  
Browse to the desired image file and press Select.  This will insert the image into the Document 
Window.   
 

 
 
 Insert Image Icon 
 
Important Things to Remember about Using Images 
 
It is against U.S. copyright law to take images from someone else's web page and display them on 
your own pages without permission. 
 
Always make sure that your images are small – both in dimensions and in file size. The smaller the 
file, the faster it will download and be displayed on your page. I try to keep my images under 100k. 
 
Always make your images the size you want them to display before inserting them into your page. 
Don't insert them and then resize them. 
 
Always supply alternate text for your images using the Alt field in the properties panel. This helps 
users with vision disabilities who can't see your images understand what your images are about. 
Use short, descriptive words for your alternative text. 
 
Formatting Images 
 
Once inserted, you can use the tools available to you in the Properties Panel to resize and align 
the image (left, center, right), make the image into a link, or place a border around your image.  
 
You may notice that images you insert into your page are contained in their own paragraph. There 
are two ways to make other content – like text – wrap around your images. One is with tables, and 
the other is with alignment, as shown in the following image: 
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Changing the value of the Align field to Left will make text wrap around your image on the right. 
Similarly, changing the value of the Align field to Right will make text wrap around your image on 
the left.  
 
 

Inserting Tables 
 
To insert a table into your web page, place the cursor in Document Window the location you would 
like the table inserted.  Next, click on the Insert Table icon in Common Object Toolbar.   
 

 
 

 
 

Insert Table Icon

     Fall, 2007 Dreamweaver Basics Page 23 



 

 

The Insert 
Table Dialogue 
Window 

 
The Insert Table dialogue window allows you to control all aspects of your table: how many rows 
and columns it has, how wide it is, whether or not it has a border, and if it does, how thick that 
border is, how much space there is between cells (cellspacing), how much space there is between 
a cell’s content and the edge of the cell (cellpadding), header rows and/or columns, and more. Text 
inside header rows and columns is automatically bolded and centered. Have text appear above 
your table by entering a Caption.  
 
Once the desired format has been specified in the Insert Table dialogue box, press OK.  The table 
will now be inserted into your Web page in the Document Window.  You will then be able to place 
your cursor in each cell to add text or images. 
 
Once you insert your table, you can make additional changes to the table’s format by selecting the 
table and using the Properties Panel to make change the number of rows and columns, the 
amount of cell padding and cell spacing, the alignment and width of your table, and the size of the 
table’s border. 
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Laying Out a Page 

 
Using Tables 

 
The most common way of organizing a web page's layout is using tables. Starting from a 
blank, new Basic HTML page, insert a table as shown above. Make sure to make your table to 
100% wide with a border width of 0, no header rows or columns and no caption.  
 
In the following example, I have created a table with three rows and three columns. I then 
selected all three cells in the first row and merged them using the Merge Cells Icon in the 
Properties Panel. I did the same for all three cells in the third column. This creates header and 
footer rows and a three-column area in between. Make sure that all of your cells are set to 
Vertical Alignment: Top. 
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Table cells can contain any content including headings, paragraphs, lists, links, nested tables, 
images, Flash animations and video clips. Table cells can use background colors and 
background images. Here is an example of a page laid out with tables: 
 

 
 
 
Using Dreamweaver's Sample Pages 
 
Dreamweaver comes with built in sample page designs that you can use to set up your pages. Go 
to File -> New and choose the Page From Sample category on the left hand side and Starter 
Page (Theme) to see a list of these sample page designs: 
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You can use any of these sample designs to create your own web pages. Just replace the sample 
text and images with your own text and images. 
 
Using a Consistent Page Design for Multiple Pages 
 
Once you have gotten your first page formatted the way you like it, you can use it as a 
template for other pages in your web site. After saving the file, click the File drop-down menu 
and choose Save As… and save it with a new file name. Now you have a new file and a new 
page. Change the content appropriately. Remember to save the page title for the title bar as 
well. 
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Previewing Your Site 
 
It is important to preview your site in several browsers before you post your site in order to ensure 
the content will be displayed appropriately.  You can preview your document at any time, but keep 
in mind that links will not be active until the site is previewed or posted to a server.   
 
To preview your document, you must first select a browser.  To do so, click the Preview/Debug 
Icon in Browser icon in the File Toolbar and choose to Edit Browser List. 
 
 

 
 
 
 

Preview/Debug in Browser Icon  
 
 

 
 
 
 
 
 
 
 
 

Choose + or –  to add or 
delete a browser
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Select “Edit” to edit 
the preferences in the 
selected browser 

Select Preview 
in Browser 

Press OK

 
After the browser has been selected or changed, you can preview the site by clicking the 
Preview/Debug Icon in the File Toolbar. You can also press the F12 key on your keyboard to 
display the current document in the primary browser.   
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Uploading Files 
 
Once your site has been defined, you can publish your site.  This means you can transfer your files 
to a server so others may have access to your web site through the Internet.   
 
Your Site Files panel is always visible on the left side of the Dreamweaver work area.  You can see 
both your local and remote files at any time by clicking the Expand/Collapse button at the top of the 
Site Files panel. 
 

  
The Expand/Collapse button 

 
 
Clicking the Expand/Collapse button will open a Site Window with two panes, one for the Local 
Folder and one for the Remote Site.   
 
Local Folder 
The Local Folder appears on the right-hand side of the window and contains a list of the files 
stored on your computer or network.   
 
Remote Site 
The Remote Site appears on the left-hand side of the window and shows a list of the files stored on 
the server.  Until you connect to the server, the Remote Site side of the window will remain blank. 
 

 

Remote Site  Local Folder 
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To connect to the server and view the Remote Site, click the Connect button in the Site Files 
toolbar.  
 

 

Connect Button 

 
 
 

               Get File(s)    Put File(s) 
Once you have connected to the server, you can transfer files from the Local Folder to the Remote 
Site and vice versa.  You can do this by dragging selected files from one pane to the other, or by 
using the Get File(s) and Put File(s) buttons in the toolbar. 
 
When you transfer files to the server, you will be asked if you want to Include Dependent Files.  
Including Dependent Files means that all the files dependent on the file you are transferring 
(images, external style sheets) will also be transferred to the server. 
 
Keep in mind that when you transfer files, you overwrite the existing file.  Make sure you do not 
copy over the most recent version, or the edits will be lost.   
 
 

Viewing Your Published Site 
 
To view your published site, open a web browser and go to  
http://www-personal.umich.edu/~youruniquename/filename.html. 
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